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Q.3 Select the most appropriate option to fill in the blank.

We _____________ the meeting with a message from the President.

Ans 1. are being begun

2. will have begin

3. will begin

4. had been beginning

Question ID : 630680292992

Option 1 ID : 6306801139804

Option 2 ID : 6306801139805

Option 3 ID : 6306801139806

Option 4 ID : 6306801139807

Status : Answered

Chosen Option : 3

Q.4 Select the most appropriate preposition to fill in the blank.

They ought to be here ______ now.

Ans 1. in

2. besides

3. by

4. for

Question ID : 630680293134

Option 1 ID : 6306801140369

Option 2 ID : 6306801140371

Option 3 ID : 6306801140370

Option 4 ID : 6306801140368

Status : Answered

Chosen Option : 3

Q.5 Select the most appropriate meaning of the given idiom.

Pie in the sky

Ans 1. Something that seems bad but provides some benefit

2. Slightly unwell or feeling low

3. Forced to do something that you would not do

4. Idea or plan that is very unlikely to happen

Question ID : 630680292997

Option 1 ID : 6306801139824

Option 2 ID : 6306801139825

Option 3 ID : 6306801139827

Option 4 ID : 6306801139826

Status : Answered

Chosen Option : 4
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Q.6 Select the option that expresses the given sentence in indirect speech.

They said to her, “We elected you as Miss Universe in Miami.”

Ans 1. They told her she elects her as Miss Universe in Miami.

2. They told her they are elect her as Miss Universe in Miami.

3. They told her that we will elect her as Miss Universe in Miami.

4. They told her that they had elected her as Miss Universe in Miami.

Question ID : 630680292990

Option 1 ID : 6306801139799

Option 2 ID : 6306801139797

Option 3 ID : 6306801139798

Option 4 ID : 6306801139796

Status : Answered

Chosen Option : 4

Q.7 Sentences of a paragraph are given below. While the first and the last sentences (S1
and S6) are in correct order, the sentences in between are jumbled up. Arrange the
sentences in the correct order to form a meaningful and coherent paragraph.
S1. Phatik was sitting at the river bank chewing a piece of grass.
P. He saw Phatik sitting there and asked where the Chakravortis lived.
Q. A middle-aged man with grey hair and dark moustache, stepped on the shore.
R. Phatik went on chewing the grass, and said, “Over there!” It was difficult to tell
where he pointed.
S. A boat came up to the landing.
S6. The stranger asked again but Phatik gave a curt reply.

Ans 1. RSQP

2. SQPR

3. PQRS

4. QSRP

Question ID : 630680292969

Option 1 ID : 6306801139713

Option 2 ID : 6306801139714

Option 3 ID : 6306801139712

Option 4 ID : 6306801139715

Status : Answered

Chosen Option : 2

Q.8 Select the most appropriate option to fill in the blank.

She does not call me every day, ____________________?

Ans 1. doesn’t she

2. does she

3. hasn’t she

4. did she

Question ID : 630680292986

Option 1 ID : 6306801139782

Option 2 ID : 6306801139783

Option 3 ID : 6306801139781

Option 4 ID : 6306801139780

Status : Answered

Chosen Option : 2
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Q.9 What does the following proverb mean:
Discretion is the better part of valour.

Ans 1. Using cunningness to end fighting is better than fighting bravely.

2. Planning should come before execution

3. It is wise to be careful and avoid unnecessary risks

4. Delaying action unless necessary is what makes one brave.

Question ID : 630680296369

Option 1 ID : 6306801153146

Option 2 ID : 6306801153147

Option 3 ID : 6306801153145

Option 4 ID : 6306801153144

Status : Answered

Chosen Option : 3

Q.10 Select the most appropriate option to fill in the blank.

My uncle took us to the show, ________________?

Ans 1. did he

2. does he

3. didn’t he

4. doesn’t he

Question ID : 630680292983

Option 1 ID : 6306801139768

Option 2 ID : 6306801139770

Option 3 ID : 6306801139769

Option 4 ID : 6306801139771

Status : Answered

Chosen Option : 3

Q.11 Select the option that can be used as a one-word substitute for the given group of
words.

The process of official registration as a member of any institution

Ans 1. Entrant

2. Entitlement

3. Enrollment

4. Allotment

Question ID : 630680293079

Option 1 ID : 6306801140151

Option 2 ID : 6306801140150

Option 3 ID : 6306801140148

Option 4 ID : 6306801140149

Status : Answered

Chosen Option : 3
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Q.12 Select the most appropriate option to fill in the blank.

My cousin asked me ______________ I would arrive.

Ans 1. after

2. when

3. now

4. until

Question ID : 630680292977

Option 1 ID : 6306801139747

Option 2 ID : 6306801139744

Option 3 ID : 6306801139746

Option 4 ID : 6306801139745

Status : Answered

Chosen Option : 2

Q.13 Select the option with correct spelling that can substitute the underlined word in the
given sentence.
Prashant’s group considered the alternative of resetling the orphans in their own
community.

Ans 1. resettleing

2. reesettling

3. resettling

4. reseatling

Question ID : 630680292964

Option 1 ID : 6306801139694

Option 2 ID : 6306801139693

Option 3 ID : 6306801139692

Option 4 ID : 6306801139695

Status : Answered

Chosen Option : 3

Q.14 Select the most appropriate meaning of the given idiom.

Beat about the bush

Ans 1. Talk about something without coming to the main point

2. Get punishment for doing unfair things

3. To obey orders immediately

4. To keep on talking endlessly

Question ID : 630680293137

Option 1 ID : 6306801140380

Option 2 ID : 6306801140382

Option 3 ID : 6306801140381

Option 4 ID : 6306801140383

Status : Answered

Chosen Option : 1

5 of 47 25-10-2023, 09:52

https://www.adda247.com/
https://applink.adda247.com/d/XhqWf9lSap


Q.15 Select the most appropriate option to fill in the blank.

The school will shortly close for _____ Puja holidays.

Ans 1. an

2. these

3. a

4. the

Question ID : 630680293132

Option 1 ID : 6306801140362

Option 2 ID : 6306801140363

Option 3 ID : 6306801140361

Option 4 ID : 6306801140360

Status : Answered

Chosen Option : 4

Q.16 Sentences of a paragraph are given below in jumbled order. Arrange the sentences in
the correct order to form a meaningful and coherent paragraph.

A. However, it is important to know that, besides novelty, originality is also an
important characteristic of creative thinking.

B. Creative thinking thus refers to originality and uniqueness of ideas or solutions that
did not previously exist.

C. Creative thinking is distinguished from other types of thinking by the fact that it
involves the production of novel and original ideas or solutions to problems.

D. Every year, new models of household appliances, cars and other items produced
may not be original unless unique features are added to these products.

E. Sometimes, creative thinking is understood just as a new way of thinking or
thinking differently.

Ans 1. CEDAB

2. CEADB

3. BDAEC

4. ABCED

Question ID : 630680293265

Option 1 ID : 6306801140887

Option 2 ID : 6306801140884

Option 3 ID : 6306801140885

Option 4 ID : 6306801140886

Status : Answered

Chosen Option : 2

Q.17 Select the option that can be used as a one-word substitute for the given group of
words.

Something that can get rotten

Ans 1. Perishable

2. Fragile

3. Resistant

4. Sturdy

Question ID : 630680293081

Option 1 ID : 6306801140158

Option 2 ID : 6306801140159

Option 3 ID : 6306801140157

Option 4 ID : 6306801140156

Status : Answered

Chosen Option : 2
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Q.18 What does the following idiom mean:
Sticky fingers

Ans 1. To be in a situation one cannot be rid of

2. To be unclean

3. To be overly attached to someone

4. With a tendency to steal

Question ID : 630680296368

Option 1 ID : 6306801153141

Option 2 ID : 6306801153140

Option 3 ID : 6306801153142

Option 4 ID : 6306801153143

Status : Answered

Chosen Option : 1

Q.19 Select the MISSPELT word in the following sentence.

William Shakespeare is considred to be one of the greatest dramatists in English,
whose plays have been translated into every major language in the world.

Ans 1. translated

2. dramatists

3. language

4. considred

Question ID : 630680293069

Option 1 ID : 6306801140110

Option 2 ID : 6306801140109

Option 3 ID : 6306801140111

Option 4 ID : 6306801140108

Status : Answered

Chosen Option : 4

Q.20 Sentences of a paragraph are given below in jumbled order. Select the option that
arranges the sentences in the correct sequence to form a meaningful and coherent
paragraph.

P. Oaks, beeches, birches, chestnuts, maples, elms, and lindens are a few examples of
deciduous trees.

Q. The leaf chlorophyll degrades from green to brown, red, and golden.

R. Every year, deciduous trees lose their leaves in autumn.

S. This is done to reduce their requirement for water which may be frozen.

Ans 1. R, S, Q, P

2. R, P, Q, S

3. R, S, P, Q

4. R, Q, P, S

Question ID : 630680293076

Option 1 ID : 6306801140138

Option 2 ID : 6306801140137

Option 3 ID : 6306801140136

Option 4 ID : 6306801140139

Status : Answered

Chosen Option : 1
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Q.21 Select the option that can be used as a one-word substitute for the given group of
words.
Person who does not drink alcohol

Ans 1. Traitor

2. Troglodyte

3. Teetotaller

4. Toady

Question ID : 630680292975

Option 1 ID : 6306801139736

Option 2 ID : 6306801139739

Option 3 ID : 6306801139738

Option 4 ID : 6306801139737

Status : Answered

Chosen Option : 3

Comprehension:

Read the given passage and answer the question that follows.

Incredible though it may seem, while the percentage of literacy in India has been going up,
the number of illiterates has also been increasing. According to the 1966 figures, there were
353 million illiterates in the country – 20 million more than in 1961. During the same period,
the percentage of literacy went up from 24% to 29%. The explanation for this paradox lies in
the rapid growth of population, which has outpaced whatever little progress has been
achieved in literacy. For instance, from 1951 to 1961, literacy increased at an annual average
rate of 0.7%, while the country’s population grew by 2.15% every year. But the population
explosion is not entirely responsible for the growing number of illiterates.

The apathy of most states in failing to tackle the problem of adult literacy is also partly to
blame. Till now, they have shown little awareness of the magnitude of the problem. Moreover,
follow up measures to prevent neo literates from relapsing into illiteracy are just as important
as the initial adult literacy campaigns. Here too, the State Education Authorities have been
negligent. Not sufficient provisions have been made for continued education. This can be
done by setting up more rural libraries, adult schools and correspondence courses.

SubQuestion No : 22

Q.22 What is the paradox referred to in the passage?

Ans 1. The number of literates and the percentage of literacy have both decreased.

2. The number of illiterates and the percentage of literacy have both increased.

3. The number of literates has gone down, while the percentage of literacy has also
decreased.

4. The number of literates has increased, while the percentage of literacy has gone
down.

Question ID : 630680415952

Option 1 ID : 6306801622574

Option 2 ID : 6306801622571

Option 3 ID : 6306801622573

Option 4 ID : 6306801622572

Status : Answered

Chosen Option : 2
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Comprehension:

Read the given passage and answer the question that follows.

Incredible though it may seem, while the percentage of literacy in India has been going up,
the number of illiterates has also been increasing. According to the 1966 figures, there were
353 million illiterates in the country – 20 million more than in 1961. During the same period,
the percentage of literacy went up from 24% to 29%. The explanation for this paradox lies in
the rapid growth of population, which has outpaced whatever little progress has been
achieved in literacy. For instance, from 1951 to 1961, literacy increased at an annual average
rate of 0.7%, while the country’s population grew by 2.15% every year. But the population
explosion is not entirely responsible for the growing number of illiterates.

The apathy of most states in failing to tackle the problem of adult literacy is also partly to
blame. Till now, they have shown little awareness of the magnitude of the problem. Moreover,
follow up measures to prevent neo literates from relapsing into illiteracy are just as important
as the initial adult literacy campaigns. Here too, the State Education Authorities have been
negligent. Not sufficient provisions have been made for continued education. This can be
done by setting up more rural libraries, adult schools and correspondence courses.

SubQuestion No : 23

Q.23 Identify the structure of the passage.

Ans 1. Problem / Solution

2. Proposition / Support

3. Investigation

4. Description

Question ID : 630680415950

Option 1 ID : 6306801622563

Option 2 ID : 6306801622566

Option 3 ID : 6306801622565

Option 4 ID : 6306801622564

Status : Answered

Chosen Option : 1

Comprehension:

Read the given passage and answer the question that follows.

Incredible though it may seem, while the percentage of literacy in India has been going up,
the number of illiterates has also been increasing. According to the 1966 figures, there were
353 million illiterates in the country – 20 million more than in 1961. During the same period,
the percentage of literacy went up from 24% to 29%. The explanation for this paradox lies in
the rapid growth of population, which has outpaced whatever little progress has been
achieved in literacy. For instance, from 1951 to 1961, literacy increased at an annual average
rate of 0.7%, while the country’s population grew by 2.15% every year. But the population
explosion is not entirely responsible for the growing number of illiterates.

The apathy of most states in failing to tackle the problem of adult literacy is also partly to
blame. Till now, they have shown little awareness of the magnitude of the problem. Moreover,
follow up measures to prevent neo literates from relapsing into illiteracy are just as important
as the initial adult literacy campaigns. Here too, the State Education Authorities have been
negligent. Not sufficient provisions have been made for continued education. This can be
done by setting up more rural libraries, adult schools and correspondence courses.

SubQuestion No : 24

Q.24 Identify a suitable title for the passage.

Ans 1. Illiteracy in India

2. Population Explosion

3. Literacy in India

4. Literacy Campaign

Question ID : 630680415949

Option 1 ID : 6306801622560

Option 2 ID : 6306801622561

Option 3 ID : 6306801622559

Option 4 ID : 6306801622562

Status : Answered

Chosen Option : 1
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Comprehension:

Read the given passage and answer the question that follows.

Incredible though it may seem, while the percentage of literacy in India has been going up,
the number of illiterates has also been increasing. According to the 1966 figures, there were
353 million illiterates in the country – 20 million more than in 1961. During the same period,
the percentage of literacy went up from 24% to 29%. The explanation for this paradox lies in
the rapid growth of population, which has outpaced whatever little progress has been
achieved in literacy. For instance, from 1951 to 1961, literacy increased at an annual average
rate of 0.7%, while the country’s population grew by 2.15% every year. But the population
explosion is not entirely responsible for the growing number of illiterates.

The apathy of most states in failing to tackle the problem of adult literacy is also partly to
blame. Till now, they have shown little awareness of the magnitude of the problem. Moreover,
follow up measures to prevent neo literates from relapsing into illiteracy are just as important
as the initial adult literacy campaigns. Here too, the State Education Authorities have been
negligent. Not sufficient provisions have been made for continued education. This can be
done by setting up more rural libraries, adult schools and correspondence courses.

SubQuestion No : 25

Q.25 Identify the tone of the passage.

Ans 1. Humorous

2. Serious

3. Informal

4. Fearful

Question ID : 630680415951

Option 1 ID : 6306801622567

Option 2 ID : 6306801622569

Option 3 ID : 6306801622568

Option 4 ID : 6306801622570

Status : Answered

Chosen Option : 2

Q.1 According to the Indian calendar, sharada season falls in which months?

Ans 1. Jyaistha-Asadha

2. Chaitra-Vaisakha

3. Asvina-Kartika

4. Margashirsa-Pausa

Question ID : 630680299763

Option 1 ID : 6306801165993

Option 2 ID : 6306801165991

Option 3 ID : 6306801165992

Option 4 ID : 6306801165994

Status : Not Answered

Chosen Option : --

Q.2 According to the Census of India 2011, which of the following states has the highest
density of population per square kilometre?

Ans 1. Arunachal Pradesh

2. Bihar

3. Madhya Pradesh

4. West Bengal

Question ID : 630680299765

Option 1 ID : 6306801166000

Option 2 ID : 6306801166002

Option 3 ID : 6306801165999

Option 4 ID : 6306801166001

Status : Answered

Chosen Option : 2

Section : Section A General Knowledge
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Q.3 Which of the following types of administrative lists is NOT mentioned in the
Constitution of India?

Ans 1. Provisional list

2. Union list

3. State list

4. Concurrent list

Question ID : 630680293305

Option 1 ID : 6306801141045

Option 2 ID : 6306801141044

Option 3 ID : 6306801141046

Option 4 ID : 6306801141047

Status : Answered

Chosen Option : 1

Q.4 Which Buddhist literature does NOT come under canonical literature?

Ans 1. Abhidhamma Pitaka

2. Sutta Pitaka

3. Milinda Panho

4. Vinaya Pitaka

Question ID : 630680300777

Option 1 ID : 6306801169925

Option 2 ID : 6306801169924

Option 3 ID : 6306801169926

Option 4 ID : 6306801169923

Status : Answered

Chosen Option : 3

Q.5 The famous epic Ramayana written by Valmiki is divided into how many khandas?

Ans 1. 7 khandas

2. 5 khandas

3. 11 khandas

4. 8 khandas

Question ID : 630680300781

Option 1 ID : 6306801169940

Option 2 ID : 6306801169939

Option 3 ID : 6306801169942

Option 4 ID : 6306801169941

Status : Not Answered

Chosen Option : --

Q.6 Which of the following features of the Constitution of India was NOT mentioned in the
Government of India Act of 1935?

Ans 1. Judiciary

2. Office of Governor

3. Cabinet System

4. Federal System

Question ID : 630680293295

Option 1 ID : 6306801141007

Option 2 ID : 6306801141006

Option 3 ID : 6306801141005

Option 4 ID : 6306801141004

Status : Answered

Chosen Option : 2
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Q.7 Who among the following is NOT a part of the Indian Parliament?

Ans 1. President

2. Lok Sabha

3. Rajya Sabha

4. Governor

Question ID : 630680293310

Option 1 ID : 6306801141064

Option 2 ID : 6306801141066

Option 3 ID : 6306801141067

Option 4 ID : 6306801141065

Status : Answered

Chosen Option : 4

Q.8 Study of the relations between living organisms, including humans, and their physical
environment is known as:

Ans 1. geomorphology

2. seismology

3. ecology

4. palaeontology

Question ID : 630680293249

Option 1 ID : 6306801140820

Option 2 ID : 6306801140822

Option 3 ID : 6306801140823

Option 4 ID : 6306801140821

Status : Answered

Chosen Option : 3

Q.9 When consumption is independent of income, it is known as:

Ans 1. induced consumption

2. autonomous consumption

3. income led consumption

4. aggregate consumption

Question ID : 630680293290

Option 1 ID : 6306801140987

Option 2 ID : 6306801140986

Option 3 ID : 6306801140984

Option 4 ID : 6306801140985

Status : Answered

Chosen Option : 2

Q.10 The Jhelum is a tributary of which river?

Ans 1. Godavari River

2. Yamuna River

3. Indus River

4. Ganga River

Question ID : 630680299755

Option 1 ID : 6306801165962

Option 2 ID : 6306801165961

Option 3 ID : 6306801165959

Option 4 ID : 6306801165960

Status : Answered

Chosen Option : 2
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Q.11 The process of separating bacteria, particularly spores from specific bacterial strains,
from milk by using a specifically built hermetic centrifuge is called:

Ans 1. homogenisation

2. bactofugation

3. pasteurisation

4. coagulation

Question ID : 630680293254

Option 1 ID : 6306801140843

Option 2 ID : 6306801140841

Option 3 ID : 6306801140840

Option 4 ID : 6306801140842

Status : Answered

Chosen Option : 3

Q.12 Which of the following options best describes the main purpose of the flower of a
plant?

Ans 1. To store excess water for the plant

2. To produce seeds for reproduction

3. To capture carbon dioxide from the atmosphere

4. To produce oxygen for respiration

Question ID : 630680293260

Option 1 ID : 6306801140866

Option 2 ID : 6306801140867

Option 3 ID : 6306801140864

Option 4 ID : 6306801140865

Status : Answered

Chosen Option : 2

Q.13 On the basis of the percentage of Muslim population in the states (2011), arrange the
following states in descending order.
A)Assam
B)West Bengal
C)Kerala

Ans 1. (C), (B), (A)

2. (C), (A), (B)

3. (A), (B), (C)

4. (B), (A), (C)

Question ID : 630680299779

Option 1 ID : 6306801166056

Option 2 ID : 6306801166057

Option 3 ID : 6306801166055

Option 4 ID : 6306801166058

Status : Answered

Chosen Option : 2
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Q.14 Which of the following is a constitutional body?

Ans 1. Advocate General of State

2. State Human Rights Commission

3. NITI Aayog

4. Lokpal and Lokayukta

Question ID : 630680293299

Option 1 ID : 6306801141022

Option 2 ID : 6306801141021

Option 3 ID : 6306801141023

Option 4 ID : 6306801141020

Status : Answered

Chosen Option : 4

Q.15 The Saddle Peak is located in which part of Andaman Island?

Ans 1. North Andaman

2. Great Andaman

3. Middle Andaman

4. South Andaman

Question ID : 630680299753

Option 1 ID : 6306801165951

Option 2 ID : 6306801165954

Option 3 ID : 6306801165952

Option 4 ID : 6306801165953

Status : Not Answered

Chosen Option : --

Q.1 A shopkeeper bought 12 dozen eggs at the rate of ₹5 per egg. 12 eggs broke in transit.
He sold the remaining eggs at the rate of ₹6 per egg. Find his percentage of profit.

Ans 1. 10%

2. 20%

3. 5%

4. 15% 

Question ID : 630680315027

Option 1 ID : 6306801225906

Option 2 ID : 6306801225907

Option 3 ID : 6306801225905

Option 4 ID : 6306801225908

Status : Answered

Chosen Option : 2

Q.2 A parallelogram has one parallel side length of 12 cm and perpendicular distance
between its base and other parallel side is 8 cm. Its area is ______.

Ans 1. 48 cm2

2. 96 cm2

3. 192 cm2

4. 24 cm2

Question ID : 630680315052

Option 1 ID : 6306801226006

Option 2 ID : 6306801226005

Option 3 ID : 6306801226008

Option 4 ID : 6306801226007

Status : Answered

Chosen Option : 2

Section : Section A Logical Reasoning or Quantitative Aptitude
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Q.3 Two train engines of the same length are running in the same direction with speeds of
18 km/h and 36 km/h. If the faster engine crosses the slower one in 8 sec, then what is
the length of each train engine?

Ans 1. 30 m 

2. 20 m 

3. 25 m 

4. 10 m 

Question ID : 630680315042

Option 1 ID : 6306801225968

Option 2 ID : 6306801225966

Option 3 ID : 6306801225967

Option 4 ID : 6306801225965

Status : Answered

Chosen Option : 2

Q.4 Three of the following four letter-clusters are alike in a certain way and thus form a
group. Which letter-cluster does not belong to that group?

Ans 1. PMT

2. TQY

3. ROV

4. NKR

Question ID : 630680293726

Option 1 ID : 6306801142726

Option 2 ID : 6306801142724

Option 3 ID : 6306801142725

Option 4 ID : 6306801142727

Status : Answered

Chosen Option : 2

Q.5 Select the triad in which the letter-clusters are related in the same way as are the
letter-clusters of the given triads.
(Both the triads follow the same pattern.)
RU-SV-XY
JM-KN-PQ

Ans 1. GJ-HK-MP

2. FI-GJ-LO

3. EH-FI-KL

4. HK-IL-NQ

Question ID : 630680293721

Option 1 ID : 6306801142706

Option 2 ID : 6306801142705

Option 3 ID : 6306801142704

Option 4 ID : 6306801142707

Status : Answered

Chosen Option : 3
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Q.6 What will come in the place of the question mark (?) in the following equation if ‘+’ and
‘−’ are interchanged and ‘×’ and ‘÷’ are interchanged?
5 ÷ 6 + 10 − 24 × 8 = ?

Ans 1. 21

2. 22

3. 25

4. 23

Question ID : 630680293748

Option 1 ID : 6306801142812

Option 2 ID : 6306801142815

Option 3 ID : 6306801142814

Option 4 ID : 6306801142813

Status : Answered

Chosen Option : 4

Q.7 Refer to the given series and answer the question that follows.
(All numbers are single digit numbers only.)
(Left) 3 6 9 7 4 5 2 4 2 1 5 7 9 8 5 3 6 2 1 7 3 7 8 4 7 4 1 (Right)
How many such odd digits are there each of which is immediately preceded by an
even digit and also immediately followed by an odd digit?

Ans 1. 1

2. 3

3. 2

4. 4

Question ID : 630680293709

Option 1 ID : 6306801142656

Option 2 ID : 6306801142658

Option 3 ID : 6306801142657

Option 4 ID : 6306801142659

Status : Answered

Chosen Option : 4

Q.8 Find the mean proportional between 17 and 68.

Ans 1. 38

2. 46

3. 34

4. 42

Question ID : 630680315032

Option 1 ID : 6306801225926

Option 2 ID : 6306801225928

Option 3 ID : 6306801225925

Option 4 ID : 6306801225927

Status : Answered

Chosen Option : 3
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Q.9 Seven men can complete a work in 12 days. They start the work and after 5 days, 3
men leave. In how many days will the remaining work be completed by the remaining
men?

Ans 1. 

2. 

3. 

4. 

Question ID : 630680315044

Option 1 ID : 6306801225976

Option 2 ID : 6306801225974

Option 3 ID : 6306801225973

Option 4 ID : 6306801225975

Status : Answered

Chosen Option : 4

Q.10 Kartik starts from Point A and drives 13 km towards the north. He then takes a left
turn, drives 5 km, turns right and drives 3 km. He then takes a right turn and drives 15
km. He takes a final right turn, drives 16 km and stops at Point P. How far (shortest
distance) and towards which direction should he drive in order to reach Point A again?
(All turns are 90 degrees turns only, unless specified)

Ans 1. 8 km to the east

2. 8 km to the west

3. 10 km to the west

4. 10 km to the east

Question ID : 630680298152

Option 1 ID : 6306801159690

Option 2 ID : 6306801159689

Option 3 ID : 6306801159687

Option 4 ID : 6306801159688

Status : Answered

Chosen Option : 3

Q.11 What is the least 5-digit number, which when divided by 15, 24, 35 and 42, the
remainder in each case is 13?

Ans 1. 10,106

2. 10,073

3. 10,093

4. 10,067

Question ID : 630680315016

Option 1 ID : 6306801225864

Option 2 ID : 6306801225863

Option 3 ID : 6306801225862

Option 4 ID : 6306801225861

Status : Answered

Chosen Option : 4
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Q.12 If ‘A’ stands for ‘+’, ‘B’ stands for ‘−’, ‘C’ stands for ‘×’ and ‘D’ stands for ‘÷’, what will
come in place of the question mark (?) in the following equation?
10 A 72 D 8 B 4 C 3 = ?

Ans 1. 9

2. 8

3. 7

4. 6

Question ID : 630680293742

Option 1 ID : 6306801142791

Option 2 ID : 6306801142790

Option 3 ID : 6306801142788

Option 4 ID : 6306801142789

Status : Answered

Chosen Option : 3

Q.13 Varun’s salary was first decreased by 16% and subsequently increased by 25%. Find
the net percentage change in his salary.

Ans 1. 5% increase

2. 5% decrease 

3. 10% decrease

4. 10% increase

Question ID : 630680315022

Option 1 ID : 6306801225885

Option 2 ID : 6306801225887

Option 3 ID : 6306801225888

Option 4 ID : 6306801225886

Status : Answered

Chosen Option : 1

Q.14 What should come in place of the question mark (?) in the given series?
22, 29, 43, 64, 92, ?

Ans 1. 122

2. 125

3. 127

4. 131

Question ID : 630680293737

Option 1 ID : 6306801142768

Option 2 ID : 6306801142771

Option 3 ID : 6306801142769

Option 4 ID : 6306801142770

Status : Answered

Chosen Option : 3

Firefox https://cdn.digialm.com//per/g01/pub/1258/touchstone/Assessment...
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Q.15 What should come in place of the question mark (?) in the given series in order to
make it logically complete?
OR25, NQ27, MP31, LO37, ?

Ans 1. KN47

2. LM47

3. KN45

4. LM45

Question ID : 630680293714

Option 1 ID : 6306801142678

Option 2 ID : 6306801142679

Option 3 ID : 6306801142676

Option 4 ID : 6306801142677

Status : Answered

Chosen Option : 3

Q.16 X and Y are two alloys of Gold and Platinum prepared by mixing the metals in the ratio
of 5 : 2 and 5 : 7, respectively. If we melt equal quantities of the alloys to form a third
alloy Z, then the ratio of the quantity of Gold to the quantity of Platinum in Z will be:

Ans 1. 95 : 73

2. 95 : 84

3. 73 : 95

4. 84 : 73

Question ID : 630680315033

Option 1 ID : 6306801225930

Option 2 ID : 6306801225932

Option 3 ID : 6306801225929

Option 4 ID : 6306801225931

Status : Answered

Chosen Option : 1

Q.17 A group of people contains men, women and children. If 40% of them are men, 35% are
women and rest are children, and their average weights are 70 kg, 60 kg and 30 kg,
respectively, then the average weight of the group is:

Ans 1. 45.5 kg

2. 56.5 g

3. 56.5 kg

4. 46.5 g

Question ID : 630680315020

Option 1 ID : 6306801225879

Option 2 ID : 6306801225877

Option 3 ID : 6306801225880

Option 4 ID : 6306801225878

Status : Answered

Chosen Option : 3
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Q.18 Two banks, A and B, offered loans at 4.5% and 5.5% per annum, respectively. Ramesh
borrowed an amount of ₹2,00,000 from each bank. Find the positive difference in the
amounts of simple interest paid to the two banks by Ramesh after 2 years.

Ans 1. ₹8,000

2. ₹6,000

3. ₹4,000

4. ₹2,000

Question ID : 630680315035

Option 1 ID : 6306801225937

Option 2 ID : 6306801225938

Option 3 ID : 6306801225940

Option 4 ID : 6306801225939

Status : Answered

Chosen Option : 3

Q.19 If 1 is added to each odd digit and 2 is subtracted from each even digit in the number
5138746, what will be the sum of the digits which are second from the left and third
from the right of the number thus formed?

Ans 1. 10

2. 11

3. 8

4. 9

Question ID : 630680298150

Option 1 ID : 6306801159681

Option 2 ID : 6306801159682

Option 3 ID : 6306801159679

Option 4 ID : 6306801159680

Status : Answered

Chosen Option : 1

Q.20 What should come in place of the question mark (?) in the given series?
11, 19, 27, 35, 43, ?

Ans 1. 42

2. 51

3. 50

4. 49

Question ID : 630680293730

Option 1 ID : 6306801142743

Option 2 ID : 6306801142742

Option 3 ID : 6306801142741

Option 4 ID : 6306801142740

Status : Answered

Chosen Option : 2

Section : Section A Computer Knowledge
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Q.1 Which of the following is the correct sequence of steps to open a Power Point
presentation in Microsoft Power Point?

Ans 1. Click on the ‘Insert’ tab > Click ‘Open’ > Browse and select the presentation file >
Click ‘Open’

2. Click on the ‘View’ tab > Click ‘Open Presentation’ > Browse and select the
presentation file > Click ‘Open’

3. Click on the ‘File' tab > Select ‘Open’ > Browse and select the presentation file >
Click ‘Open’

4. Click on the ‘Home’ tab > Click ‘New Slide’ > Select ‘Open Presentation’ > Browse
and select the presentation file > Click ‘OK’

Question ID : 630680312623

Option 1 ID : 6306801216376

Option 2 ID : 6306801216375

Option 3 ID : 6306801216373

Option 4 ID : 6306801216374

Status : Answered

Chosen Option : 3

Q.2 Which of the following in Microsoft Excel allows you to create a visual representation
of data using graphical elements such as bars, columns, or pie slices?

Ans 1. Charts

2. Conditional Formatting

3. Formulas

4. Data Tables

Question ID : 630680312639

Option 1 ID : 6306801216439

Option 2 ID : 6306801216438

Option 3 ID : 6306801216440

Option 4 ID : 6306801216437

Status : Answered

Chosen Option : 1

Q.3 Which Excel feature allows you to rearrange data in a specific order, either from lowest
to highest or from highest to lowest?

Ans 1. Sorting

2. Filtering

3. Autofill

4. Conditional Formatting

Question ID : 630680312642

Option 1 ID : 6306801216451

Option 2 ID : 6306801216452

Option 3 ID : 6306801216449

Option 4 ID : 6306801216450

Status : Answered

Chosen Option : 1
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Q.4 Which of the following statements about input/output (I/O) devices is true?

Ans 1. A webcam is an example of a touch input device.

2. A barcode scanner is an output device used to convert barcodes into text or
numerical data.

3. An optical disc drive is an input device used to read data from optical discs such as
CDs and DVDs.

4. A graphics tablet is an output device used to create digital drawings directly on the
computer screen.

Question ID : 630680312671

Option 1 ID : 6306801216567

Option 2 ID : 6306801216566

Option 3 ID : 6306801216565

Option 4 ID : 6306801216568

Status : Answered

Chosen Option : 3

Q.5 Which of the following is considered the first mechanical computer?

Ans 1. IBM 360

2. ENIAC

3. Apple Macintosh

4. Analytical Engine

Question ID : 630680312675

Option 1 ID : 6306801216584

Option 2 ID : 6306801216581

Option 3 ID : 6306801216582

Option 4 ID : 6306801216583

Status : Answered

Chosen Option : 1

Q.6 In MS Word, which option allows you to delete a specific row from a table while
ensuring that the remaining rows adjust automatically to fill the gap?

Ans 1. Delete Columns

2. Delete Cells

3. Delete Table

4. Delete Row

Question ID : 630680312660

Option 1 ID : 6306801216524

Option 2 ID : 6306801216522

Option 3 ID : 6306801216523

Option 4 ID : 6306801216521

Status : Answered

Chosen Option : 4

Q.7 In Microsoft Word, which method allows you to copy the formatting of selected text
and apply it to other text in the document?

Ans 1. Styles

2. AutoCorrect

3. Format Painter

4. Clipboard

Question ID : 630680312650

Option 1 ID : 6306801216483

Option 2 ID : 6306801216484

Option 3 ID : 6306801216481

Option 4 ID : 6306801216482

Status : Answered

Chosen Option : 1
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Q.8 Which function can be used to create a series of dates with a specific increment in MS
Excel?

Ans 1. Edate

2. Series

3. Date value

4. Date add

Question ID : 630680332659

Option 1 ID : 6306801294072

Option 2 ID : 6306801294070

Option 3 ID : 6306801294071

Option 4 ID : 6306801294069

Status : Answered

Chosen Option : 2

Q.9 One or more defects occurring in computer software that prevent the software from
working is called:

Ans 1. software crash

2. software bug

3. software failure

4. software glitch

Question ID : 630680312677

Option 1 ID : 6306801216592

Option 2 ID : 6306801216590

Option 3 ID : 6306801216589

Option 4 ID : 6306801216591

Status : Answered

Chosen Option : 2

Q.10 Which of the following file types is commonly used for storing multimedia content
such as audio, video, images and animations?

Ans 1. Multimedia file

2. Configuration file

3. Text file

4. Binary file

Question ID : 630680312691

Option 1 ID : 6306801216647

Option 2 ID : 6306801216648

Option 3 ID : 6306801216645

Option 4 ID : 6306801216646

Status : Answered

Chosen Option : 1

Q.11 Which option in MS PowerPoint allows you to control the appearance and behaviour of
a slide show during its delivery?

Ans 1. Slide Transitions

2. Presenter View

3. Animation Effects

4. Slide Show Setup

Question ID : 630680323673

Option 1 ID : 6306801259193

Option 2 ID : 6306801259195

Option 3 ID : 6306801259194

Option 4 ID : 6306801259196

Status : Answered

Chosen Option : 2
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Q.12 Which of the following concepts describes the ability of an operating system to run
multiple applications simultaneously by dividing the CPU time among them?

Ans 1. Multiuser

2. Multithreading

3. Multiprocessing

4. Multitasking

Question ID : 630680312699

Option 1 ID : 6306801216680

Option 2 ID : 6306801216677

Option 3 ID : 6306801216679

Option 4 ID : 6306801216678

Status : Answered

Chosen Option : 2

Q.13 In MS Word, which option from the Menu Bar provides access to a comprehensive set
of help topics, tutorials and troubleshooting guides?

Ans 1. Help

2. Home

3. View

4. File

Question ID : 630680312667

Option 1 ID : 6306801216552

Option 2 ID : 6306801216550

Option 3 ID : 6306801216551

Option 4 ID : 6306801216549

Status : Answered

Chosen Option : 1

Q.14 Which of the following is the primary file management tool in Windows OS that allows
users to navigate, organise and access files and folders on their computer system?

Ans 1. Task Manager

2. Control Panel

3. File Explorer

4. File Manager

Question ID : 630680312685

Option 1 ID : 6306801216622

Option 2 ID : 6306801216623

Option 3 ID : 6306801216624

Option 4 ID : 6306801216621

Status : Answered

Chosen Option : 3
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Q.15 When creating a presentation using a template in Microsoft PowerPoint, which of the
following statements is NOT true?

Ans 1. Templates can be customised by changing colours, fonts, and adding or removing
elements.

2. Templates save time and effort by providing a starting point for creating professional-
looking presentations.

3. Templates are only available in the default PowerPoint installation and cannot be
downloaded or imported.

4. Templates provide pre-designed layouts and formatting options for slides.

Question ID : 630680312628

Option 1 ID : 6306801216394

Option 2 ID : 6306801216396

Option 3 ID : 6306801216395

Option 4 ID : 6306801216393

Status : Answered

Chosen Option : 3

Q.1 The New Pension scheme came into effect from which of the following?

Ans 1. 1.1.2003

2. 1.1.2006

3. 1.1.2004

4. 1.1.2002

Question ID : 630680415947

Option 1 ID : 6306801622558

Option 2 ID : 6306801622556

Option 3 ID : 6306801622555

Option 4 ID : 6306801622557

Status : Answered

Chosen Option : 2

Q.2 What is the maximum amount of study leave, which may be granted to a government
servant during his entire career under the CCS (Leave) Rules?

Ans 1. Thirty-six months

2. Eighteen months

3. Twelve months

4. Twenty-four months

Question ID : 630680415911

Option 1 ID : 6306801622414

Option 2 ID : 6306801622411

Option 3 ID : 6306801622412

Option 4 ID : 6306801622413

Status : Answered

Chosen Option : 4

Section : Domain and Technical Knowledge
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Q.3 Who can commute retrospectively periods of absence without leave into extraordinary
leave under the CCS (Leave) Rules?

Ans 1. The authority competent to grant leave

2. The central government

3. The superior government servant

4. The head of department

Question ID : 630680415903

Option 1 ID : 6306801622380

Option 2 ID : 6306801622382

Option 3 ID : 6306801622381

Option 4 ID : 6306801622379

Status : Answered

Chosen Option : 1

Q.4 PPAN is a:

Ans 1. a unique 16 digit Permanent Pension Account Number

2. a unique 10 digit Permanent Pension Account Number

3. a unique 11 digit Permanent Pension Account Number

4. a unique 14 digit Permanent Pension Account Number

Question ID : 630680415946

Option 1 ID : 6306801622554

Option 2 ID : 6306801622551

Option 3 ID : 6306801622552

Option 4 ID : 6306801622553

Status : Not Answered

Chosen Option : --

Q.5 Which of the following is not a minor penalty under the CCS (CCA) Rules?

Ans 1. reduction to a lower stage in the time-scale of pay for a specified period

2. withholding of increments of pay

3. withholding promotion

4. censure

Question ID : 630680415877

Option 1 ID : 6306801622277

Option 2 ID : 6306801622278

Option 3 ID : 6306801622276

Option 4 ID : 6306801622275

Status : Answered

Chosen Option : 4

Q.6 The first four digits of Permanent Pension Account Number (PPAN) number will
indicate which of the following?

Ans 1. The calendar year of joining Govt. service,

2. The calendar year of when the last promotion was due

3. The date of birth of the govt servant

4. The year of selection to the present post

Question ID : 630680415930

Option 1 ID : 6306801622488

Option 2 ID : 6306801622489

Option 3 ID : 6306801622490

Option 4 ID : 6306801622487

Status : Not Answered

Chosen Option : --
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Q.7 The limitation period allowed for appeal under CCS (CCA) rules is:

Ans 1. 90 days

2. 30 days

3. 45 days

4. 60 days

Question ID : 630680415885

Option 1 ID : 6306801622309

Option 2 ID : 6306801622307

Option 3 ID : 6306801622310

Option 4 ID : 6306801622308

Status : Answered

Chosen Option : 2

Q.8 Who shall be the appointing authority for Central Civil Services, Group ‘A’ as per the
CCS (CCA) Rules?

Ans 1. Govt of India

2. Dept of Personnel & training

3. President on recommendation of GOI

4. The President

Question ID : 630680415875

Option 1 ID : 6306801622267

Option 2 ID : 6306801622270

Option 3 ID : 6306801622269

Option 4 ID : 6306801622268

Status : Answered

Chosen Option : 2

Q.9 As per Rule 3 of the CENTRAL SERVICES (MEDICAL ATTENDANCE) RULES, 1944
MEDICAL ATTENDANCE means:

Ans 1. A Government servant shall be given attendance for the treatment.

2. A Government servant can claim, free of charge medical treatment by the authorised
medical attendant.

3. A Government servant shall be entitled, free of charge to medical attendance by the
authorised medical attendant.

4. A Government servant shall be entitled, medical attendance by the authorised
medical attendant.

Question ID : 630680415913

Option 1 ID : 6306801622422

Option 2 ID : 6306801622421

Option 3 ID : 6306801622420

Option 4 ID : 6306801622419

Status : Not Answered

Chosen Option : --
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Q.10 From which of the following dates pension becomes payable under the CCS Pension
Rules

Ans 1. The day on which he performs the duty

2. Date on which a government servant ceases to be borne on the establishment

3. The date of his retirement

4. The 65th birthday of the government servant

Question ID : 630680415926

Option 1 ID : 6306801622473

Option 2 ID : 6306801622472

Option 3 ID : 6306801622471

Option 4 ID : 6306801622474

Status : Answered

Chosen Option : 3

Q.11 Study leave will be granted only to which of the following government servant CCS
(Leave) Rules?

Ans 1. who has satisfactorily completed period of probation and has rendered not less than
five years' regular continuous service including the period of probation under the Government

2. who has satisfactorily completed period of probation and has rendered not less than
seven years' regular continuous service including the period of probation under the
Government

3. who has satisfactorily completed period of probation

4. who has rendered ten years continuous services

Question ID : 630680415909

Option 1 ID : 6306801622403

Option 2 ID : 6306801622406

Option 3 ID : 6306801622404

Option 4 ID : 6306801622405

Status : Answered

Chosen Option : 3

Q.12 The display by a Government servant on his person, vehicle or residence of any
electoral symbol shall amount which of the following under the CCS (Conduct Rules)
1964.

Ans 1. using his influence in connection with an election

2. canvassing

3. active part in politics

4. following political ideology

Question ID : 630680415892

Option 1 ID : 6306801622335

Option 2 ID : 6306801622336

Option 3 ID : 6306801622337

Option 4 ID : 6306801622338

Status : Answered

Chosen Option : 1
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Q.13 No Government servant shall be granted leave of any kind for a continuous period
exceeding ______ Under the CCS (Leave) Rules.

Ans 1. Five yeas

2. Three years

3. Two years

4. One year

Question ID : 630680415912

Option 1 ID : 6306801622418

Option 2 ID : 6306801622415

Option 3 ID : 6306801622417

Option 4 ID : 6306801622416

Status : Answered

Chosen Option : 2

Q.14 FR 10 provides for which of the following?

Ans 1. A Government servant who has acquired lien on a post retains the lien on that post

2. No person may be appointed in India to a post in Government service without a
medical certificate of health

3. The President may transfer Government servant from one post to another

4. Travelling allowance

Question ID : 630680415918

Option 1 ID : 6306801622441

Option 2 ID : 6306801622439

Option 3 ID : 6306801622442

Option 4 ID : 6306801622440

Status : Answered

Chosen Option : 1

Q.15 Under the CENTRAL CIVIL SERVICES (CONDUCT) RULES, 1964 The government
servnats are prohibited from joining any association if objects or activities of which
are prejudicial to the interests of the sovereignty and integrity of India, or ______

Ans 1. Justice and morality

2. Morality ethics

3. Public order or morality

4. Law and order

Question ID : 630680415891

Option 1 ID : 6306801622334

Option 2 ID : 6306801622332

Option 3 ID : 6306801622333

Option 4 ID : 6306801622331

Status : Answered

Chosen Option : 3

Q.16 Rule 40 of the CCS (Leave) Rules provides for which of the following?

Ans 1. Leave salary

2. Extraordinary leave

3. Drawal of leave salary

4. Advance of leave salary

Question ID : 630680415905

Option 1 ID : 6306801622388

Option 2 ID : 6306801622387

Option 3 ID : 6306801622390

Option 4 ID : 6306801622389

Status : Not Answered

Chosen Option : --
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Q.17 Advance of leave salary may be allowed up to which of the following under the CCS
(leave) Rules?

Ans 1. A Month’s pay and allowances

2. 15 day’s salary

3. 6 months salary and allowances

4. 2 months salary and allowances

Question ID : 630680415906

Option 1 ID : 6306801622393

Option 2 ID : 6306801622394

Option 3 ID : 6306801622391

Option 4 ID : 6306801622392

Status : Not Answered

Chosen Option : --

Q.18 If the patient is serious and it requires consultation with specialist, whose approval is
required under the Central Services Medical Attendance Rules 1944?

Ans 1. Authorised medical officer

2. Medical Superintendent of district

3. Chief Administrative Medical Officer of the State

4. Chief medical officer

Question ID : 630680415915

Option 1 ID : 6306801622430

Option 2 ID : 6306801622427

Option 3 ID : 6306801622429

Option 4 ID : 6306801622428

Status : Answered

Chosen Option : 1

Q.19 Application under 4 (b) of the CENTRAL SERVICES (MEDICAL ATTENDANCE) RULES,
1944 need to be accompanied with which of the following:

Ans 1. Certificate that medical attendance was necessary.

2. Certificate that that the patient was too ill to travel.

3. Certificate that patient is in serious condition.

4. Certificate that no nearby medical facility existed.

Question ID : 630680415914

Option 1 ID : 6306801622425

Option 2 ID : 6306801622423

Option 3 ID : 6306801622426

Option 4 ID : 6306801622424

Status : Not Answered

Chosen Option : --

Q.20 An applicant under rule 7 of the Central Civil Services (Commutation of Pension)
Rules, 1981 is required to make Nomination in which of the following forms?

Ans 1. Form 2

2. Form 3

3. Form 5

4. Form 8

Question ID : 630680415929

Option 1 ID : 6306801622484

Option 2 ID : 6306801622483

Option 3 ID : 6306801622486

Option 4 ID : 6306801622485

Status : Not Answered

Chosen Option : --
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Q.21 As provided under the CCS (CCA) Rules an appeal against an order in a common
proceeding held under Rule 18 shall lie to the authority to which the authority
functioning as the ______ for the purpose of that proceeding is immediately
subordinate:

Ans 1. reviewing authority

2. higher authority

3. disciplinary authority

4. appointing authority

Question ID : 630680415884

Option 1 ID : 6306801622304

Option 2 ID : 6306801622305

Option 3 ID : 6306801622306

Option 4 ID : 6306801622303

Status : Answered

Chosen Option : 4

Q.22 The appeal shall be presented to the authority to whom the appeal lies, a copy being
forwarded by the appellant to which of the following under the CCS (CCA) Rules:

Ans 1. The opposite party

2. Appointing authority

3. Disciplinary authority

4. Authority which made the order appealed against.

Question ID : 630680415886

Option 1 ID : 6306801622314

Option 2 ID : 6306801622313

Option 3 ID : 6306801622311

Option 4 ID : 6306801622312

Status : Not Answered

Chosen Option : --

Q.23 According to rule 8 of the Central Civil Services (Commutation of Pension) Rules, 1981
The lump sum payable to an applicant shall be calculated in accordance with the
______ and applicable to the applicant on the date on which the commutation
becomes absolute.

Ans 1. Notification released by Government

2. As per rules of the concerned department he is attached with

3. As per his entitlements

4. Table of the values prescribed from time to time

Question ID : 630680415928

Option 1 ID : 6306801622480

Option 2 ID : 6306801622482

Option 3 ID : 6306801622481

Option 4 ID : 6306801622479

Status : Not Answered

Chosen Option : --
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Q.24 In respect of a probationer undergoing training at the Lal Bahadur Shastri National
Academy of Administration who shall be the authority competent to impose on such
probationer any of the penalties specified in rule 11 of the CCS (CCA) Rules?

Ans 1. Any authority superior to the probationer

2. Secretary to Govt of India

3. The Director of the Academy

4. Govt of India

Question ID : 630680415878

Option 1 ID : 6306801622282

Option 2 ID : 6306801622281

Option 3 ID : 6306801622280

Option 4 ID : 6306801622279

Status : Answered

Chosen Option : 3

Q.25 Against which of the following order the appeal lies under the CCS (CCA) rules:

Ans 1. any order of an interlocutory nature

2. any order passed by an inquiring authority in the course of an inquiry under Rule 14.

3. an order enhancing any penalty, imposed under rule 11

4. any order made by the President;

Question ID : 630680415882

Option 1 ID : 6306801622297

Option 2 ID : 6306801622298

Option 3 ID : 6306801622296

Option 4 ID : 6306801622295

Status : Answered

Chosen Option : 3

Q.26 What is the maximum amount of leave not due to which a permanent government
servant is entitled under the CCS (Leave) Rules?

Ans 1. 360 days

2. 320 days

3. 120 days

4. 300 days

Question ID : 630680415902

Option 1 ID : 6306801622377

Option 2 ID : 6306801622378

Option 3 ID : 6306801622375

Option 4 ID : 6306801622376

Status : Answered

Chosen Option : 4

Q.27 According to GFR 2017, Fundamental principles of public buying (for all procurements
including procurement of works) includes all the following except?

Ans 1. open bidding

2. efficiency, economy, and transparency in matters relating to public procurement

3. fair and equitable treatment of suppliers

4. promotion of competition in public procurement

Question ID : 630680415939

Option 1 ID : 6306801622526

Option 2 ID : 6306801622525

Option 3 ID : 6306801622524

Option 4 ID : 6306801622523

Status : Answered

Chosen Option : 4
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Q.28 According to GFR 2017, The financial powers of the Government, which have not been
delegated to a subordinate authority, shall vest in which of the following?

Ans 1. The minister of finance

2. The Finance Ministry

3. The Prime minister

4. The secretary of the department

Question ID : 630680415933

Option 1 ID : 6306801622499

Option 2 ID : 6306801622500

Option 3 ID : 6306801622501

Option 4 ID : 6306801622502

Status : Answered

Chosen Option : 2

Q.29 Which of the following is condition for grant of commuted leave under the CCS (leave)
Rules?

Ans 1. He has served for 5 years without break

2. No other leaves have been clubbed with the same

3. No disciplinary action initiated so far

4. There is reasonable prospect of the Government servant returning to duty on its
expiry

Question ID : 630680415901

Option 1 ID : 6306801622371

Option 2 ID : 6306801622374

Option 3 ID : 6306801622373

Option 4 ID : 6306801622372

Status : Answered

Chosen Option : 2

Q.30 Articles 112 to 116 of the Constitution of India contains provision regarding which of
the following?

Ans 1. The provisions for submission of budget

2. The provision for categories of budget

3. The provision for passing of budget

4. The provisions for preparation, formulation, and submission of budget

Question ID : 630680415936

Option 1 ID : 6306801622512

Option 2 ID : 6306801622514

Option 3 ID : 6306801622513

Option 4 ID : 6306801622511

Status : Answered

Chosen Option : 4
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Q.31 Which of the following is a condition when family of the deceased shall be entitled to a
family pension under CCS Pension Rules?

Ans 1. Where a Government servant dies after completion of three year of continuous
service

2. Where a Government servant dies after completion of one year of continuous service

3. Where a Government servant dies after completion of five year of continuous service

4. Where a Government servant dies after completion of two year of continuous service

Question ID : 630680415925

Option 1 ID : 6306801622467

Option 2 ID : 6306801622469

Option 3 ID : 6306801622470

Option 4 ID : 6306801622468

Status : Answered

Chosen Option : 1

Q.32 According to GFR, If the contents of any file are categorized as ‘Secret’ or ‘Top Secret’
the file maybe sent personally to which of the following?

Ans 1. To the audit firm only

2. The auditor

3. Head of the Audit Office

4. The superior officer only

Question ID : 630680415935

Option 1 ID : 6306801622510

Option 2 ID : 6306801622507

Option 3 ID : 6306801622509

Option 4 ID : 6306801622508

Status : Answered

Chosen Option : 4

Q.33 What is the limit as per rule 5 of the Central Civil Services (Commutation of Pension)
Rules, 1981 on commutation of pension?

Ans 1. A Government servant shall be entitled to commute for a lump sum payment of an
amount not exceeding fifty percent of his pension

2. A Government servant shall be entitled to commute for a lump sum payment of an
amount not exceeding sixty percent of his pension

3. A Government servant shall be entitled to commute for a lump sum payment of an
amount not exceeding forty percent of his pension

4. A Government servant shall be entitled to commute for a lump sum payment of an
amount not exceeding thirty percent of his pension

Question ID : 630680415927

Option 1 ID : 6306801622475

Option 2 ID : 6306801622478

Option 3 ID : 6306801622477

Option 4 ID : 6306801622476

Status : Answered

Chosen Option : 3
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Q.34 According to GFR rule 73, The main principles according to which the accounts of the
Government of India shall be maintained are contained which of the following?

Ans 1. Government Accounting Rules, 1990

2. Rule for Treasuries

3. Account code volume II

4. Government Accounting Rules, 1990; Accounting Rules for Treasuries; and Account
Code Volume III

Question ID : 630680415937

Option 1 ID : 6306801622517

Option 2 ID : 6306801622516

Option 3 ID : 6306801622515

Option 4 ID : 6306801622518

Status : Not Answered

Chosen Option : --

Q.35 Under New Pension Scheme PFRDA stands for:

Ans 1. Permanent Fund Regulatory and Development and Authority

2. Pension Fund Regulatory and Development Authority

3. Pension Fund Regulatory Authority

4. Pension finance Regulatory and Development and Authority

Question ID : 630680415945

Option 1 ID : 6306801622550

Option 2 ID : 6306801622547

Option 3 ID : 6306801622548

Option 4 ID : 6306801622549

Status : Answered

Chosen Option : 2

Q.36 A Ministry or Department at its discretion may directly execute repair works estimated
to cost up to which of the following as provided under GFR 2017?

Ans 1. Rupees Ten Lakhs

2. Rupees two Lakhs

3. Rupees Thirty Lakhs

4. Rupees Twenty Lakhs

Question ID : 630680415938

Option 1 ID : 6306801622522

Option 2 ID : 6306801622519

Option 3 ID : 6306801622520

Option 4 ID : 6306801622521

Status : Not Answered

Chosen Option : --

Q.37 Rule 15 of the CENTRAL CIVIL SERVICES (CONDUCT) RULES, 1964 provided for
which of the following?

Ans 1. Evidence before Committee or any other authority

2. Criticism of government

3. Public demonstrations in honour of Government servants

4. Private trade or employment

Question ID : 630680415893

Option 1 ID : 6306801622341

Option 2 ID : 6306801622339

Option 3 ID : 6306801622342

Option 4 ID : 6306801622340

Status : Answered

Chosen Option : 4
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Q.38 Superannuation pension is provide under which of the following of CCS Pension
Rules?

Ans 1. Rule 33

2. Rule 34

3. Rule 30

4. Rule 29

Question ID : 630680415923

Option 1 ID : 6306801622460

Option 2 ID : 6306801622459

Option 3 ID : 6306801622462

Option 4 ID : 6306801622461

Status : Not Answered

Chosen Option : --

Q.39 Repeal and saving of the CENTRAL CIVIL SERVICES (CONDUCT) RULES, 1964 is
provided under which of the following?

Ans 1. Rule 25

2. Rule 18

3. Rule 30

4. Rule 28

Question ID : 630680415898

Option 1 ID : 6306801622362

Option 2 ID : 6306801622359

Option 3 ID : 6306801622361

Option 4 ID : 6306801622360

Status : Answered

Chosen Option : 1

Q.40 Performance of his official duties, and acting in a discourteous manner is amounting
to violation of which of the following under the CCS (Conduct Rules) 1964:

Ans 1. Promptness and Courtesy

2. Loyalty

3. Ethics

4. Competence & loyalty

Question ID : 630680415888

Option 1 ID : 6306801622320

Option 2 ID : 6306801622321

Option 3 ID : 6306801622319

Option 4 ID : 6306801622322

Status : Answered

Chosen Option : 1

Q.41 As per CCS (CCA) Rules the central services are divided into how many groups?

Ans 1. 6

2. 4

3. 5

4. 3

Question ID : 630680415873

Option 1 ID : 6306801622262

Option 2 ID : 6306801622260

Option 3 ID : 6306801622261

Option 4 ID : 6306801622259

Status : Answered

Chosen Option : 3
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Q.42 Under the CENTRAL CIVIL SERVICES (CONDUCT) RULES, 1964 For the vindication of
any official act which has been the subject-matter of adverse criticism or an attack of a
defamatory character the government servants are prohibited to do which of the
following?

Ans 1. To approach secretary of the department

2. To approach media and court

3. To approach president

4. To approach the appointing authority

Question ID : 630680415894

Option 1 ID : 6306801622343

Option 2 ID : 6306801622344

Option 3 ID : 6306801622345

Option 4 ID : 6306801622346

Status : Answered

Chosen Option : 2

Q.43 Central Civil posts of any Group not included in any other Central Civil Service shall
be deemed to be included in the ______ Central Service of the corresponding
Group according to CCS (CCA) Rules. Fill in the blank from below:

Ans 1. Specific

2. Central

3. General

4. Designated

Question ID : 630680415874

Option 1 ID : 6306801622263

Option 2 ID : 6306801622264

Option 3 ID : 6306801622265

Option 4 ID : 6306801622266

Status : Not Answered

Chosen Option : --

Q.44 As per GFR 2017, Under ______ of the Constitution all moneys received by or
deposited with any officer employed in connection with the affairs of the Union in his
capacity as such, other than revenues or public moneys raised or received by
Government, shall be paid into the Public Account.

Ans 1. Article 281

2. Article 284

3. Article 285

4. Article 280

Question ID : 630680415932

Option 1 ID : 6306801622495

Option 2 ID : 6306801622497

Option 3 ID : 6306801622498

Option 4 ID : 6306801622496

Status : Answered

Chosen Option : 3
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Q.45 Orders against which no appeal lies is provided under which of the following under
the CCS (CCA) Rules:

Ans 1. Rule 23

2. Rule 14

3. Rule 17

4. Rule 22

Question ID : 630680415883

Option 1 ID : 6306801622302

Option 2 ID : 6306801622299

Option 3 ID : 6306801622300

Option 4 ID : 6306801622301

Status : Not Answered

Chosen Option : --

Q.46 The minimum number of consultants shortlisted under rule 184 of GFR 2017 shall be?

Ans 1. 5

2. 9

3. 3

4. 7

Question ID : 630680415940

Option 1 ID : 6306801622527

Option 2 ID : 6306801622530

Option 3 ID : 6306801622529

Option 4 ID : 6306801622528

Status : Not Answered

Chosen Option : --

Q.47 Central Civil Services (Leave) Rules, 1972. Came into effect from which of the
following?

Ans 1. 1st day of April, 1972.

2. 1st day of March, 1972.

3. 1st day of July, 1972.

4. 1st day of June, 1972.

Question ID : 630680415922

Option 1 ID : 6306801622455

Option 2 ID : 6306801622457

Option 3 ID : 6306801622456

Option 4 ID : 6306801622458

Status : Answered

Chosen Option : 3

Q.48 Under the CENTRAL CIVIL SERVICES (CONDUCT) RULES, 1964 Observance of
Government's policies means ______

Ans 1. not to help enemy states

2. respect human rights

3. observe the Government's policies regarding prevention of crime against women.

4. upholding the ideals of nation

Question ID : 630680415889

Option 1 ID : 6306801622324

Option 2 ID : 6306801622323

Option 3 ID : 6306801622326

Option 4 ID : 6306801622325

Status : Answered

Chosen Option : 3
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Q.49 The leave account of every Government servant (other than a military officer) except in
Vacation Department, shall be credited with earned leave, in advance, in two
installments of how many days under the CCS (Leave) Rules.

Ans 1. 15 days each on the first day of January and July of every calendar year.

2. 10 days each on the first day of January and July of every calendar year

3. 30 days each on the first day of January and July of every calendar year

4. 20 days each on the first day of January and June of every calendar year

Question ID : 630680415900

Option 1 ID : 6306801622367

Option 2 ID : 6306801622368

Option 3 ID : 6306801622370

Option 4 ID : 6306801622369

Status : Answered

Chosen Option : 1

Q.50 As per New Pension Scheme Tier I, Govt. servants will have to contribute ______ of his
Basic Pay, DP and DA.

Ans 1. 7%

2. 20%

3. 5%

4. 10%

Question ID : 630680415944

Option 1 ID : 6306801622546

Option 2 ID : 6306801622543

Option 3 ID : 6306801622545

Option 4 ID : 6306801622544

Status : Not Answered

Chosen Option : --

Q.51 Rule 15 of the CCS (CCA) Rules deals with:

Ans 1. Minor penalties

2. Action on inquiry report

3. Disciplinary authority

4. Major penalties

Question ID : 630680415879

Option 1 ID : 6306801622284

Option 2 ID : 6306801622286

Option 3 ID : 6306801622285

Option 4 ID : 6306801622283

Status : Answered

Chosen Option : 2

Q.52 The term Emoluments under CCS Pension Rule 2021 means:

Ans 1. Net salary

2. Basic pay

3. In hand salary

4. Gross salary

Question ID : 630680415924

Option 1 ID : 6306801622464

Option 2 ID : 6306801622466

Option 3 ID : 6306801622465

Option 4 ID : 6306801622463

Status : Answered

Chosen Option : 4
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Q.53 All of the following have power of Revision under rule 29 of the CCS (CCA) rules
except?

Ans 1. Appointing authority

2. The appellate authority

3. Comptroller and Auditor-General

4. President

Question ID : 630680415887

Option 1 ID : 6306801622317

Option 2 ID : 6306801622318

Option 3 ID : 6306801622316

Option 4 ID : 6306801622315

Status : Answered

Chosen Option : 1

Q.54 Surplus or obsolete or unserviceable goods of assessed residual value above Rupees
Two Lakh should be disposed of by which of the following methods under GFR Rule
218.

Ans 1. Public auction

2. Open competition

3. By authorised agent

4. Online advertisement

Question ID : 630680415941

Option 1 ID : 6306801622531

Option 2 ID : 6306801622534

Option 3 ID : 6306801622533

Option 4 ID : 6306801622532

Status : Answered

Chosen Option : 3

Q.55 Rule 16 A of THE GENERAL PROVIDENT FUND (CENTRAL SERVICES) RULES, 1960
provides for which of the following?

Ans 1. Payment towards insurance policies

2. Assignment of policies

3. Conversion of an advance into a withdrawal

4. Reduction of subscription in certain cases

Question ID : 630680415931

Option 1 ID : 6306801622491

Option 2 ID : 6306801622494

Option 3 ID : 6306801622493

Option 4 ID : 6306801622492

Status : Not Answered

Chosen Option : --
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Q.56 Willful absence from duty after the expiry of joining time may be treated as which of
the following for the purpose of Rule 15 under FR?

Ans 1. Negligence

2. Indiscipline

3. Incapacity

4. misbehavior

Question ID : 630680415921

Option 1 ID : 6306801622453

Option 2 ID : 6306801622452

Option 3 ID : 6306801622454

Option 4 ID : 6306801622451

Status : Answered

Chosen Option : 2

Q.57 A Government servant ‘s claim to leave is regulated by which of the following under
the CCS Leave Rules?

Ans 1. The rule as per terms and condition of service

2. The rules in force at the time the leave is applied for and granted

3. The rules at the date of appointment

4. The rules governing leave applicable

Question ID : 630680415904

Option 1 ID : 6306801622386

Option 2 ID : 6306801622383

Option 3 ID : 6306801622384

Option 4 ID : 6306801622385

Status : Answered

Chosen Option : 4

Q.58 According to GFR rule 277 Guarantees shall normally be restricted to the ______ and
normal interest component of the loan. Other risks shall not form part of the
guarantee.

Ans 1. The amount of loan

2. The total amount of contract

3. The amount agreed

4. Repayment of principal

Question ID : 630680415943

Option 1 ID : 6306801622539

Option 2 ID : 6306801622540

Option 3 ID : 6306801622541

Option 4 ID : 6306801622542

Status : Answered

Chosen Option : 4

41 of 47 25-10-2023, 09:52

https://www.adda247.com/
https://applink.adda247.com/d/XhqWf9lSap


Q.59 Completed years of service means continuous service of specified duration under the
Central Government and includes the period spent on duty as well as on leave
including ______ leave under the CCS (Leave) Rules.

Ans 1. Casual

2. Extraordinary

3. Medical

4. Earned

Question ID : 630680415899

Option 1 ID : 6306801622363

Option 2 ID : 6306801622364

Option 3 ID : 6306801622365

Option 4 ID : 6306801622366

Status : Answered

Chosen Option : 4

Q.60 As per rule 24 of the Fundamental Rules, An increment shall ordinarily be drawn as a
matter of course unless ______.

Ans 1. It is withheld

2. It is postponed

3. Denied on disciplinary charges

4. It is subjected to inquiry

Question ID : 630680415919

Option 1 ID : 6306801622445

Option 2 ID : 6306801622444

Option 3 ID : 6306801622446

Option 4 ID : 6306801622443

Status : Answered

Chosen Option : 3

Q.61 With regard to delegation of power under the CENTRAL CIVIL SERVICES (CONDUCT)
RULES, 1964 the power belonging to Govt and which of the following authority can be
delegated?

Ans 1. President

2. Undersecretary of the department

3. Head of department

4. Secretary of the department

Question ID : 630680415897

Option 1 ID : 6306801622358

Option 2 ID : 6306801622357

Option 3 ID : 6306801622356

Option 4 ID : 6306801622355

Status : Answered

Chosen Option : 3
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Q.62 Orders made by the disciplinary authority shall be communicated to the Government
servant who shall also be supplied with a copy of its finding on which of the following
under the CCS (CCA) Rules?

Ans 1. Each acts constituting misconduct

2. Allegations against him

3. Violations done by him

4. On each article of charge

Question ID : 630680415880

Option 1 ID : 6306801622290

Option 2 ID : 6306801622288

Option 3 ID : 6306801622287

Option 4 ID : 6306801622289

Status : Not Answered

Chosen Option : --

Q.63 According to Rule 49 (iv) of FR where an officer is formally appointed to hold full
additional charge of another post, the aggregate of pay and additional pay shall in no
case exceed ______

Ans 1. Rs 2,25,000

2. Rs 2,60,000

3. Rs 2,50,000

4. Rs 2,00,000

Question ID : 630680415920

Option 1 ID : 6306801622450

Option 2 ID : 6306801622449

Option 3 ID : 6306801622448

Option 4 ID : 6306801622447

Status : Answered

Chosen Option : 3

Q.64 Choose the correct pairing of the following as provided under the Central Services
(Medical Attendance Rules, 1944):

Ans 1. Rule 8 - TRANSFER TO FOREIGN SERVICE

2. Rule 9 - COUNTERSIGNATURE OF CERTIFICATES

3. Rule 11 - TREATMENT AT RESIDENCE

4. Rule 7 - TREATMENT OUTSIDE INDIA

Question ID : 630680415917

Option 1 ID : 6306801622435

Option 2 ID : 6306801622436

Option 3 ID : 6306801622438

Option 4 ID : 6306801622437

Status : Not Answered

Chosen Option : --
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Q.65 Which of the following is the final authority regarding interpretation of the CENTRAL
CIVIL SERVICES (CONDUCT) RULES, 1964?

Ans 1. President

2. The government

3. Supreme Court

4. Governor

Question ID : 630680415896

Option 1 ID : 6306801622353

Option 2 ID : 6306801622351

Option 3 ID : 6306801622354

Option 4 ID : 6306801622352

Status : Answered

Chosen Option : 2

Q.66 Paternity leave was added in CCS (leave) rules in which of the following year?

Ans 1. 2008

2. 2002

3. 2000

4. 2003

Question ID : 630680415908

Option 1 ID : 6306801622402

Option 2 ID : 6306801622400

Option 3 ID : 6306801622399

Option 4 ID : 6306801622401

Status : Not Answered

Chosen Option : --

Q.67 Which of the following provides for reimbursement of medical treatment by the Central
Government?

Ans 1. Rule 5

2. Rule 7

3. Rule 6 (2)

4. Rule 6 (1)

Question ID : 630680415916

Option 1 ID : 6306801622431

Option 2 ID : 6306801622433

Option 3 ID : 6306801622434

Option 4 ID : 6306801622432

Status : Not Answered

Chosen Option : --

Q.68 When a government servant has engaged himself in activities prejudicial to the
interest of the security of the State he can be subjected to which of the following
under Rule 10 of the CCS (CCA) Rules?

Ans 1. Suspension

2. Inquiry

3. Disciplinary proceeding

4. Termination

Question ID : 630680415876

Option 1 ID : 6306801622271

Option 2 ID : 6306801622274

Option 3 ID : 6306801622272

Option 4 ID : 6306801622273

Status : Answered

Chosen Option : 1
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Q.69 Which of the following does not amount to criticism of government under rule 9 of the
Central Civil Services (Conduct) Rules 1964?

Ans 1. which has the effect of an adverse criticism of any current or recent policy or action of
the Central Government

2. which can embarrass the relations between the Central Government and the
Government of any State

3. criticism of government officer

4. which can embarrass the relations between the Central Government and the
Government of any foreign State

Question ID : 630680415895

Option 1 ID : 6306801622347

Option 2 ID : 6306801622348

Option 3 ID : 6306801622349

Option 4 ID : 6306801622350

Status : Answered

Chosen Option : 3

Q.70 Under GFR 2017 Any loss or shortage of public moneys, departmental revenue or
receipts, stamps, opium, stores or other property held by, or on behalf of, Government
has to be reported to which of the following?

Ans 1. The secretary of the department

2. The head of department

3. Concerned Principal Accounts Officer

4. The auditor

Question ID : 630680415934

Option 1 ID : 6306801622505

Option 2 ID : 6306801622504

Option 3 ID : 6306801622503

Option 4 ID : 6306801622506

Status : Answered

Chosen Option : 3

Q.71 GFR provides that standard form of contracts should be adopted wherever possible,
the modifications in such contracts are permissible in which of the following ways?

Ans 1. Only with the permission of government

2. With the advice of the head of the concerned department

3. Only with the permission of the parties

4. Only after obtaining financial and legal advice

Question ID : 630680415942

Option 1 ID : 6306801622535

Option 2 ID : 6306801622538

Option 3 ID : 6306801622536

Option 4 ID : 6306801622537

Status : Answered

Chosen Option : 3
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Q.72 According to Rule 4 where the acceptance of the employment cannot await prior
permission of the Government or is otherwise considered urgent, Which of the
following is permissible under the CENTRAL CIVIL SERVICES (CONDUCT) RULES,
1964:

Ans 1. The government servant is subjected to inquiry

2. The matter shall be complianed to the Government;

3. The government servant is suspended

4. The employment may be accepted provisionally subject to the permission of the
Government.

Question ID : 630680415890

Option 1 ID : 6306801622328

Option 2 ID : 6306801622327

Option 3 ID : 6306801622329

Option 4 ID : 6306801622330

Status : Answered

Chosen Option : 4

Q.73 When Common Proceedings may be held under CCS (CCA) rules?

Ans 1. Where two or more Government servants are concerned in any case

2. To avoid multiple proceeding

3. If the punishment for the offence are identical

4. When servants are charged with same offence

Question ID : 630680415881

Option 1 ID : 6306801622291

Option 2 ID : 6306801622293

Option 3 ID : 6306801622294

Option 4 ID : 6306801622292

Status : Answered

Chosen Option : 1

Q.74 A Single male Government servant may be granted child care leave for a maximum
period of ______ during entire service for taking care of two eldest surviving children
under the CCS (Leave) Rules.

Ans 1. seven hundred and thirty days

2. seven hundred and forty days

3. two hundred and eighty days

4. three hundred and twenty days

Question ID : 630680415910

Option 1 ID : 6306801622408

Option 2 ID : 6306801622407

Option 3 ID : 6306801622409

Option 4 ID : 6306801622410

Status : Answered

Chosen Option : 1
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Q.75 How many days of maternity leave a female government servant is entitled as CCS
(Leave) Rules?

Ans 1. 180 days

2. 130 days

3. 220 days

4. 135 days

Question ID : 630680415907

Option 1 ID : 6306801622397

Option 2 ID : 6306801622395

Option 3 ID : 6306801622398

Option 4 ID : 6306801622396

Status : Answered

Chosen Option : 1
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